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WINDOWS 98
CUT, COPY, PASTE, DRAG AND DROP
Drag and Drop
To move an object, use the left mouse button to drag the object from
one folder to another on the same drive. Use Shift+Left-drag to force a
move.

To copy an object
Use the left mouse button to drag the object from one folder to another
on a different drive. Use CTRL+Left+drag to force a copy.

To create a shortcut
A shortcut to an executable file, use the left mouse button to drag an
executable file to a new folder. The icon annotations indicate what will
happen: a plus sign for copy, an arrow for a shortcut, and no symbol
for a move. Press ESC while you are dragging the object to cancel the
action.

Right Drag and Drop
Right drag and drop works like left drag and drop except that a menu is
displayed when you drop the object. The menu for folders displays these
commands: Move Here, Copy Here, Create Shortcut(s) Here.

FILE OPERATIONS
Create a New File
Create a new file by using the right mouse button to click the desktop or
folder, point to New, and then click the type of file you want to create
from the list.

Create a New Folder while Saving a File
When using the Save As command to save a file, you can also create a
new folder in which to store the file. Use the right mouse button to click
the dialog box list, point to New, and then click Folder. Double-click the
new folder to open it, and then continue the save process.

Deleting Files without moving them to Recycle Bin
Select the file or files to be deleted. Use the right mouse button to click
the selection, and then hold down the Shift key and click Delete (or hold
down the Shift key when pressing the Delete key if using the keyboard).

Restoring Files from Recycle Bin
Windows stores deleted files in the Recycle Bin, which is located on the
desktop. You can use the Recycle Bin to retrieve files you deleted in error,
or you can empty the Recycle Bin to create more disk space.

TIPS & TRICKS
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1) To restore only some of the files, hold down the CTRL key and click
each file you want to restore, then click Restore on the File menu.
2) To open a file that is in the Recycle Bin, drag the icon onto the
desktop, and then double-click it.
3) If you restore a file that was originally located in a deleted folder,
the folder is recreated, and then the file is restored in that folder.
Note: Files deleted at the command prompt, files deleted from
network locations, and files deleted from removable media (such as
diskettes) are not moved to the Recycle Bin. They are permanently
removed when you delete them and cannot be restored later.

Copying and Moving Files
Use the right mouse button to click the files you want to copy or move,
and then click Copy or Cut. Open the destination location, and then click
the right mouse button and select Paste.

To put part of a document on the desktop.
You can use this feature only if your program supports drag-and-drop
functions for OLE (Object Linking and Embedding).
1. In your document, select the text or graphic that you want to copy.
2. Drag it to the desktop.
A scrap file is created. You can now drag this scrap to other documents or
programs. To quickly send files to another place do the following:
1) Use your right mouse button to click the file you want to send.
2) Point to Send To, and then click the destination i.e Floppy,
Desktop, Fax, Printer, Email etc.

FOLDERS AND WINDOWS EXPLORER
Selecting Multiple Files
Selecting multiple files in large icon view works differently from list view.
To extend a selection, click the first icon, and then hold down the Shift
key while you click the last icon to be selected. To change an icon from
selected to unselected, hold down the CTRL key while you select the icon.

Keyboard Shortcuts
 Press Win+E to start Windows Explorer.
 Press Backspace to display the parent folder.
 To select all files in a folder, press CTRL+A.

KEYBOARD SHORTCUT KEYS






F2
F3
CTRL+X, C, or V
CTRL+ALT+DELETE
SHIFT+DELETE
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Find
Cut, Copy, or Paste
Reboot computer
Delete without putting file in Recycle Bin
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ALT+ENTER
CTRL+drag
SHIFT+F10
CTRL+SHIFT+drag

Properties
A file to a folder Copy a file
Open taskbar properties
Create a shortcut to the desktop

General control over Folders/Windows Explorer






F4 (Explorer)
F5
CTRL+G (Win Explorer)
CTRL+Z
CTRL+A

Displays the combo box
Refresh
Goto
Undo
Select all

General Keyboard-Only Commands







F1
F10
CTRL+ESC
CTRL+ESC, ESC
SHIFT
Alt+M

Help
Goes to menu mode
Brings up Start menu
Focus on the Start button
Bypasses the CD auto-run option while inserting CD
Minimizes all open windows (when two or more
windows are open)

MULTIMEDIA & SOUND
Master Volume Icon on Taskbar
You can put a master volume control, follow these steps:
1/ In Control Panel, double-click the Multimedia icon.
2/ Click the Audio tab, and then click Show Volume Control on the
taskbar.
3/ Click the volume (speaker) icon on the taskbar, near the clock to
open the master volume control.

Assigning Sounds to Events
To assign sounds to events, double-click the Sounds icon in Control
Panel. To assign a sound, do the following:
1.
2.
3.
4.

Choose a Program event
Choose a Sound from drop down list
Listen the sound you have just assigned
Click OK to apply

RUN DIALOG BOX
Via the Keyboard
1. Press CTRL+ESC+R to open the Run dialog box.
2. On a Microsoft Natural Keyboard, press Win+R to open the Run
dialog box.

Opening a Folder Anywhere From the Run Dialog Box
To open a folder, enter its local path.
For example, entering C:\Windows\System will open the System folder.
TIPS & TRICKS
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Running a Program
You can run any program with Run command from the Start Menu. If
you don't remember the location or name of the program file, click
Browse. To select a program you started recently, click the down arrow
in the Open box, click a program in the list, and then click OK.

START MENU
Keyboard Shortcuts
Press CTRL+ESC to display the Start menu. Adding items to the Start
menu, drag an object (a folder, shortcut, program, or document) onto the
Start menu to add it to the top of the Start menu. If the object is a folder,
the folder contents are displayed when you point to that menu item.

Modifying Start Menu Items
Use the right mouse button to click the Start menu, and then select
Open or Explorer to view and modify its contents.

Quick Access to Start Menu Items
You can quickly open programs at the top of the Start menu by
numbering the icons (rename them with a number before the name).
Then, Press CTRL+ESC followed by the number to start those programs.

Emptying the Documents menu
1. Click the Start menu, point to Settings, and then click Taskbar.
2. Click the Start Menu Programs tab, and then click Clear.

Start a specific program each time Windows starts
1)
2)
3)
4)
5)
6)

Click the Start button, and then point to Settings.
Click Taskbar, and then click the Start Menu Programs tab.
Click Add, and then click Browse.
Locate the program you want to start, and then double-click it.
Click Next, and then double-click the StartUp folder.
Type the name that you want to see on the StartUp menu, and then
click Finish.

TASKBAR
Hiding the Taskbar
1) Use the right mouse button to click on the Taskbar and then click
Properties.
2) Click the Taskbar Options tab, and then click Auto Hide. When
the mouse moves over the taskbar area, the taskbar appears and
when moves to other area, the taskbar disappear automatically.

Moving the Taskbar
You can drag the taskbar to any four sides of the desktop area, i.e top,
bottom (default, left, or right side of the desktop.

TIPS & TRICKS
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Languages and Keyboard Layouts
To change keyboard layouts while you work, make these changes:1. In Control Panel, double click the Keyboard icon.
2. Click the Language tab, and then add another language as needed.
Make sure the Enable Indicator on Taskbar is checked. When you
complete this setup, a Language Layout icon appears on the taskbar and
you can click the icon to select another language at any time.

SYSTEM TOOLS
System Monitor
Monitors system resources, threads, processor usage, etc. Keep it in
mind, when system monitor is on (an icon represents it in system tray) it
uses much system resources and RAM. Windows does not install the
System Monitor feature by default. To install it, follow these steps:
1. In Control Panel, double click Add or Remove Programs.
2. Click Windows Setup tab. System will build up a list of preinstalled programs in your computer.
3. Select Accessories and click Details.
4. Check the System Monitor and click OK.
5. Click OK again to complete.
6. When prompted load the Windows 98 Installation Disk in the CD
ROM drive.
Note: To install this or other Windows features, you must have
Windows 98 Installation Disk in hand.

DriveSpace
You can use DriveSpace to compress hard disks and floppy disks, which
creates more free space on the disks. You can also use DriveSpace to
configure disk drives that you have already compressed using
DoubleSpace or DriveSpace. To install DriveSpace feature, follow the
steps above.

ScanDisk
You can use ScanDisk to check your hard drives for both logical and
physical errors. ScanDisk will detect any errors, and then repair the
damaged areas automatically. ScanDisk runs automatically in the event
the operating system is shut down improperly. You can cancel this
process by pressing Escape key, but it is not recommended. ScanDisk
detects corruptions when they are most likely to occur and then corrects
them. You can also run ScanDisk at any time to evaluate your computer.
To scan your computer’s hard disks for errors, follow these steps:
1. Click Start menu, point to Programs and then Accessories.
2. Point to System Tools and click ScanDisk.
3. Select the drive you want to scan for errors. You can select more
than one drive by holding the Shift key.
4. Select Standard or Thorough (standard is recommended)
5. Select Fix Errors automatically, if not already selected.
6. Click OK.
TIPS & TRICKS
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Disk Defragmenter
Disk Defragmenter consolidates fragmented files and folders on your
computer's hard disk, so that each occupies a single, contiguous space on
the volume. As a result, your system can gain access to your files and
folders and save new ones more efficiently and speedily. By consolidating
your files and folders, Disk Defragmenter also consolidates the volume's
free space, making it less likely that new files will be fragmented. It’s
strongly recommended to run ScanDisk before going to Defragmenter. To
start disk defragmenting, follow these steps:
1.
2.
3.
4.
5.

Click Start menu, point to Programs and then Accessories.
Point to System Tools and click Disk Defragmenter.
Select the drive you want to defragment.
Click OK to start defragmenting.
Select Show details to see cluster arrangements of your files.

System File Checker
System File Checker keeps track of critical files (Windows>System folder)
that make your computer run. If these files are moved or changed, you
can restore them by using System File Checker. You need the Windows
CD to restore such files. To do so, follow these steps:
1. Click Start > Run, type sfc
2. Click Start/OK
3. Follow the information appears on the screen.

Registry Checker
Your system always keeps a backup copy of your registry configuration
(including user account information, protocol bindings, software program
settings, and user preferences). You can use the backup copy if your
current registry encounters a problem. Each time you restart your
computer, Registry Checker automatically scans your registry. If
Registry Checker notices a problem, it automatically replaces the
registry with the backup copy. To do so, follow these steps:
1.
2.
3.
4.

Click Start menu, and then Run.
Type regedit
Click Start/OK
On the Registry Editor window, open File menu and select Export.

Note: An advance user can edit various registry options manually by
exploring the relevant portion in the Registry Editor.

Backup/Restore
You can use Windows Backup feature to back up files on your hard disk.
You can back up files to floppy or zip disks, a tape drive, or another
computer on your network. If your original files are damaged or lost, you
can restore them from the backup.
Go to Start> Programs>Accessories>System Tools>Backup

WINDOWS MANAGEMENT
Switching between a Window and a Full MS-DOS Screen
Press ALT+Enter.
TIPS & TRICKS
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Closing Successive Windows
If you are using multiple windows, and want to close all open windows,
hold down the Shift key, and then click the close (X) button in the upper
right corner of the title bar.

Cascading, Tiling, and Minimizing All
Use the right mouse button to click the taskbar, and then click an option
either Cascade Windows, Tile Windows Horizontally, Tile Windows
Vertically, Show the Desktop or else.

Configuration Summary
To print a copy of your system configuration summary, double-click the
System icon in Control Panel, and then click the Device Manager tab.
Click Computer, and then click Print.

Disk Tools
Use the right mouse button to click a drive in My Computer, and then
click Properties. Click the Tools tab to use ScanDisk, Backup, and
Defragmenter.

Open With
To open an associated file with a different program, hold down Shift, and
then use the right mouse button to click the file. Click Open With on the
menu to open the file with a different program.

Screen Resolution
To quickly change screen resolution for different applications, use the
right mouse button to click the desktop, and then click the Settings tab.
In the Desktop Area, move the slider bar to the desired resolution. A
resolution of 800 by 600 pixels is the best in most cases.

Context Help
On the upper right side of each dialog box is a question mark button (?).
Click it (the question mark will run with your mouse pointer) and then
click a control or item in the dialog box for which you want to know about.
A short description of that item appears. This feature also called
Sensitive Help.

Find Tool
You can use the Find command on the Start menu to find a file, folder,
mail message, or computer (use Keyboard Shortcut F2 either). You can
search by File Name, Containing Text, by Date or by file Size. In
addition, you can save a search in the Find dialog box by clicking Save
Search on the File menu for later use. By using this feature you can find
any file/folder in your computer.

Undoing a File Move or File Rename
If you forget where you have just moved a file, or if you accidentally
rename or delete a file, click Undo from the Edit menu (or press Ctrl + Z
or ALT+Backspace).

TIPS & TRICKS
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Display Properties
Use the right mouse button to click the desktop, and then click
Properties to change the desktop Background, Screen Saver,
Appearance, or video Settings. To change your primary display font,
change the icon font on the Appearance tab.

Tips for using the System (Taskbar) Clock
Hold the mouse pointer over taskbar clock to see the date. Double click
the taskbar clock to set the system time, date, and time zone. To remove
the clock from the taskbar, do the following:
1. Use the right mouse button to click on the taskbar, and then click
Properties.
2. Click the Taskbar Options tab, and uncheck the Show Clock (or
press C). As a result, system clock will no longer be visible.

Easy Access to Computer Properties
To view your computer (system) properties, use the right mouse button
on My Computer icon on desktop and then click Properties. Alternately,
you can use keyboard shortcut WinKey + Break.

Using the Cursor Keys instead of a Mouse
You can move the cursor without using the mouse by turning on
MouseKeys. Double-click the Accessibility Options (if installed) icon in
Control Panel, click the Mouse tab, and then click Use MouseKeys.

Easy way to access Control Panel
1) Right-click the Start menu, and then click Explore.
2) Make a new directory in the Start Menu folder named Control Panel
(or whatever you want).
3) Open the original Control Panel folder, select all the icons, and then
use the right mouse button to Close everything, and then click the
Start menu. When you point to your new folder, you should see all
the Control Panel icons.

Sending Objects by using Send To
You can drag any shortcut to the SendTo folder. This shortcut could be to
a printer, fax, network drive, or Windows application. To find the SendTo
folder, click the Start button, and then click Run. Type SendTo in the
Run dialog box. Use the right mouse button to drag the item's icon into
the SendTo window. The shortcut will appear on the SendTo menu. Use
the right mouse button to click a document or folder icon, select Send To,
and then select a destination item.

Assigning WAV Files when you Open a Folder
You can assign a different .wav file to play when you open any folder in
windows explorer.
1.
2.
3.
4.

You must know a little html
Create a .wav or midi file or use one you already have.
Save the file to the C: drive in any directory.
Go to Windows Explorer and highlight the folder
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5.
6.
7.
8.
9.

Click View on the toolbar and choose Customize this Folder.
Click Create or edit an HTML document.
Click next and click next again.
Now just insert your html code for your file and then save.
Go to your folder and it should play your file.

Restoring Your Registry
Has your registry recently been damaged? To determine whether your
registry was recently damaged, restore the registry from the previous
day's backup. To restore the registry from the previous day's backup,
follow these steps:
1. Hold down the CTRL key as you restart your computer.
2. On the Startup menu, select Safe mode command prompt only.
3. Type C:\WINDOWS\COMMAND\SCANREG /RESTORE, and then
press ENTER.
4. When you are prompted, select Previous Day's Registry.
Note: If you restore a previous registry, you may need to reinstall
any programs that were installed after the registry backup was
made.
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WINDOWS XP
Dual Operating Systems
You can run TWO operating systems on a single computer simultaneously
i.e Windows 98 and Windows XP. While booting your system, a logon
screen prompt you each time at startup, which operating system do you
wants to run. While installing Windows XP as a dual OS, consider the
following points:


If you have planned to use Windows XP as well as Windows 98, be
sure do not select Upgrade during setup when prompted.



Do not install both operating systems in the same disk like C:\.



Be sure you have a handsome amount of free disk space because
Windows XP will occupy more than 1.5 GB of your hard disk.



Some of your hardware (like Modem, Printer, display adaptor,
network adaptor) and some software might not or will not work with
Windows XP due to drivers’ mismatching. However, Windows XP (at
the last stage of its installing process) tried itself to automatically
install best drivers from its own database to run your hardware
smoothly. If the drivers’ conflict persists, it may be rectified to
upgrade drivers with new compatible ones.



A live hardware compatibility report (upgrade summary) is
recommended during setup before proceeding to next step (internet
connection required).



If you have decided to upgrade your system, setup will
automatically back up your existing version of Windows i.e 95 or 98.
You can restore your computer safely even if upgrade problems
remain. To uninstall Windows XP, go to Add/Remove Programs in
Control Panel.

Seek solutions in Safe Mode or Revert your Registry
If something stops Windows in its tracks or causes it to misbehave,
reboot and press F8 before Windows loads, (you may have to press it a
few times to find the moment that gets a response). This brings up the
Advanced Options menu. Use the down/up arrow keys to select "Safe
Mode," and press Enter to launch Windows using a minimal set of
drivers. With luck, you can undo (by using System Restore Point)
whatever you did to cause the problem, and then restart Windows
normally.
If using Safe Mode doesn't solve the problem, access the Advanced
Options menu as explained above, but this time select "Last Known
Good Configuration" and press Enter. This launches Windows using the
last version of the Registry that led to a successful start-up. No files are
removed.

Add a Safe Mode option to the Boot menu
When you are experiencing a problem with Windows XP, you may need to
boot the system into Safe Mode more than once. However, doing so can
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be a tiresome process. When the Boot menu appears, you must press F8,
and then you must select Safe Mode from yet another menu. Wouldn't it
be nice if Safe Mode were available from the Boot menu? In fact, it is
relatively easy to add a Safe Mode option to the Boot menu. Here is how:
1. Press Windows+Break keys to open the System Properties
dialog box.
2. On the Advanced tab, click the Settings button in the Startup
And Recovery section.
3. In the System Startup section, click the Edit button.
4. When the Boot.ini file opens in Notepad, locate the line that ends
with the /fastdetect switch.
5. Highlight and copy that line, and paste it in the below line.
6. Change the section on the line that reads Windows="Microsoft
Windows XP Professional" to Windows="Safe Mode"
7. Finally, add the following to the end of the line:
/safeboot:minimal /sos /bootlog
8. Click OK twice to close the windows.
9. Reboot your system.

Use Driver Rollback to Remove a New Driver
Among the most critical pieces of software running on your computer are
device drivers. Drivers are executed in the kernel mode and communicate
directly with the operating system. Because they have access to parts of
the hardware and operating system that other applications cannot access,
drivers can create a great deal of damage, if written improperly.
A single driver can cause your computer to continuously crash. (Microsoft
discovered that most crashes are caused by faulty drivers.) If you have
ever experienced this for yourself, you'll appreciate a new feature in
Windows XP, called Driver Rollback. Whenever you install a new device
driver on your computer, Windows XP will create a backup copy of the old
driver. If the system crashes or if you are not satisfied with the new
driver, you can use Driver Rollback to remove the new driver and reinstall
the old driver. (The system keeps only one previous driver.)

To restore the previous driver, follow these steps:
1. Log on with an account that has administrator privileges.
2. Open Device Manager by right-clicking the My Computer icon
and selecting Properties. On the Hardware tab, click Device
Manager.
3. Right-click a device and select Properties.
4. On the Driver tab, click Roll Back Driver.
This feature works for all device drivers, except drivers for printers.
Installing printers is done through the Printers and Faxes folder and thus
doesn't support the Driver Rollback.

Run your old programs under Windows XP
If pre-XP software doesn't run under Windows' latest version (and an
update isn't available for the program), right-click the program's
shortcut and choose Properties. Select Compatibility, then click "Run
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this program in compatibility mode for," and choose the appropriate
Windows version. Click OK to finish.
Warning: Never run an antivirus program, a defragger, or any
other system utility under a version of Windows it is not intended
for. Doing so could damage your system.

Choose an account each time you Log On
You can configure any program shortcut so that Windows prompts you for
login credentials every time you double-click that shortcut. This is an ideal
solution for the Computer Management option in the Administrative Tools
folder, for instance. To specify this option follow these steps:
1.
2.

Right-click the shortcut icon and choose Properties.
On the Shortcut tab, click the Advanced button and select the Run
With Different Credentials check box.

Change the Picture on the Welcome Screen
If your computer is a member of a workgroup or is a stand-alone
computer, you can replace the picture on the Welcome screen with
another picture. First, store a head shot that you have scanned or taken
with a digital camera in the My Pictures folder. The picture will be
automatically resized to fit the picture box, so do not worry too much
about getting an exact size, and then follow these steps:
1.
2.
3.
4.

Click Start, click Control Panel, and then click User Accounts.
Click your account name, and then click Change My Picture.
Click the picture you like, and then click Change Picture.
To find the user’s picture, click Browse for more pictures, click
the picture you want to use, and then click Open.

Now, when you open the Welcome screen, you will see the new picture,
you just replaced.

Stop Password Expiration
If you are getting an error message that your password is about to
expire, following these steps to get rid of:
1.
2.
3.
4.
5.
6.
7.

Right click on the My Computer icon
Select Manage
Go to Local Users and Groups / Users
Right-click on the user you want to change
Select Properties
On the General tab, check Password never expires
Click OK

Track Down the Programs that Startup with Windows
As you may know, Windows XP provides several methods for
automatically launching programs at startup. Of course, an obvious option
is the Startup folder on the Start menu, and there is the Run key in the
registry. If you are trying to track down exactly what programs XP
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launches at startup, select the Startup tab of
Configuration Utility. To access it, follow these steps:

the

System

1. Open the Run dialog box by pressing Windows Key + R.
2. Enter msconfig in the Open text box, and click OK.
3. Select the Startup tab.
If you want any program not start when windows boot, simply deselect
that program and click Apply and then OK. Reboot your system to see
the effect if changes you have made.

Decreasing Boot Time
Microsoft has made available a program to analyze and decrease the time
it takes to boot to WindowsXP. The program is called BootVis
1.
2.
3.
4.
5.

Uncompress the file.
Run bootvis.exe
For a starting point, run Trace / Next Boot + Driver Delays
This will reboot your computer and provide a benchmark
After the reboot, BootVis will take a minute or two to show graphs
of your system startup.
6. Note how much time it takes for your system to load (click on the
red vertical line)
7. Then run Trace / Optimize System
8. Re-Run the Next Boot + Drive Delays
9. Note how much the time has decreased
10. Mine went from approximately 39 to 30 seconds.

No GUI Boot
If you don't want to see the XP boot logo, follow these steps:
1. Run Msconfig
2. Click on the Boot.Ini tab
3. Check the box for /Noguiboot

Use Single Mouse-click everywhere (no double-click)
With single–click in Windows XP, navigating the files and folders on your
hard disk is as easy as navigating the Web. You simple click an icon to
open a program or document. To start using single–click:
1. In the Tools menu in Windows Explorer, click Folder Options.
2. In the Click items as follows section, click Single–click to open
an item (point to select).
Note: To access Windows Explorer, click Start, point to All
Programs, and then click Windows Explorer.

Turning off the Default Image Viewer
You can also change the file associations for the specific file types you
want. To do so, follow these steps:
1. Open the Windows Explorer
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2.
3.
4.
5.
6.

Go to Tools / Folder Options / File Types
Scroll down to the extension you want to change
Click on the Change button
Select the program you want to associate with that extension
Click on the OK button

Disable AutoDial to Control Dial–up Connections
By default, the AutoDial feature in Windows XP connects the user to the
Internet automatically when an Internet site is accessed on the local
computer. Although this feature works well for most users, sometimes
you want to control dial–up connections manually. To turn off AutoDial
follow these steps:
1.
2.
3.
4.

Open Control Panel, click Performance and Maintenance.
Click Administrative Tools, and then double–click Services.
Double–click Remote Access Auto Connection Manager.
Click Stop to shutdown the service, then set the Startup type at
Disabled, and then click OK.

Now your computer will never try to automatically dial up an Internet
connection. To connect to the Internet manually, use whatever Internet
connection you specified in Network Connections.

Setting System Time over the Internet
You can set your system clock to a time server on the Internet. To do
this, follow these steps:
1.
2.
3.
4.

Double-click the time on your taskbar
Click the Internet Time tab
Check Automatically synchronize with an Internet time server
Click on the Update Now button

Activate Network Monitor icon
Since the Network Monitor icon is not always activated by default, you
may want to activate it yourself. To activate the icon and its indicator
"lights" do the following:1. On the desktop, right-click My Network Places, and then choose
Properties.
2. In the Network and Dial-up Connections window, double-click
Local Area Connection. On some computers, Local Area
Connection (LAN) may be listed as Wide Area Network (WAN).
3. Click Properties. Select the "Show icon in taskbar when connected"
check box at the bottom. Click OK.
An icon will display on your taskbar with a set of lights that show network
activity. It's a great way to tell if your network is transferring any data.
Bonus Tip: To display a pop-up window that provides data on the
current status of your connection—including speed and packets sent
and received—place the cursor over the Network Monitor icon. To
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display a full Status window or to disconnect the network
connection, double-click the icon.

Stop Windows Messenger from Signing In automatically
If you’re running Windows Messenger and it signs you in, even when you
don’t want it to, follow these steps to turn off signing in automatically:
1. Click Start, click Control Panel, and then click User Accounts.
2. On the Advanced tab, click Manage Passwords.
3. In Store User Names and Passwords, select Passport.Net/*,
and then click Remove.
4. This removes your Passport’s connection to your computer, but
doesn’t delete your Passport.
5. Click Close, and then click OK. When you restart Windows
Messenger, it won’t sign you in automatically.

Configuring the Firewall
WindowsXP has firewall capabilities built into the operating system. To
use this feature, follow these steps:
1.
2.
3.
4.

For your network connection to the Internet, select Properties
Click on the Advanced tab
Check the Internet Connection Firewall section
Click on the Settings button to change the settings

Fix Corrupt Event Log Files
Event Viewer is one of the administrative tools located in Microsoft
Management Console, It maintains logs about program, security, and
system events on your computer. You can use Event Viewer to view and
manage the event logs, gather information about hardware and software
problems, and monitor Windows security events.
If Event Viewer reports on startup that one or more of your log files is
corrupt, you can remedy the situation as follows:
1.
2.

Disable the Event Log service and restart Windows XP.
Delete the corrupt log(s)—Appevent.evt, Secevent.evt, and/or
Sysevent.evt—from %SystemRoot%\System32\Config (or wherever
they may be). Your existing event data will be lost, but a new log file
will be created when the service is restarted, and that log will start to
accumulate new events.
3. Reenable the Event Log service, and start the service.
4. If the Event Log service doesn’t restart successfully, then restart
Windows XP.
Note: You cannot delete or rename the log files while the Event Log
service is running.

Copy your Error Messages or get the big Error Picture
When Windows tells you something is gone wrong, you may want to
preserve the error messages to send to a support tech or your local PC
guru. To do so, just press Ctrl-C to copy the message to your Clipboard,
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open a new e-mail to your tech helper, press Ctrl-V to paste the error
alert text, and then send the message on its way.
If you cannot copy just the error message's text as described above,
press Alt+Print Screen to capture an image of the error message box.
Paste the image into your e-mail application (if it supports graphics) or
into your word processor. You can also paste the screen into Windows'
Paint imaging utility by opening that program and choosing Edit>Paste.
Save the picture as a bitmap (.bmp), JPEG (.jpg), or other file format that
you can send as an e-mail attachment to your friendly neighborhood
Windows repairperson.

Add a Picture to a Folder
If you are tired of looking at the same old folder icons and want to give
your folders some style, follow these steps to change the picture that
identifies a folder, but note that if your folder doesn’t contain an image
file, Windows won’t generate a folder picture. Moreover, you can only see
a picture on a folder when it's in Thumbnails view within another folder.
To switch to Thumbnails view, on the View menu of the open folder, click
Thumbnails.
1. Right-click a folder, and then click Properties.
2. Click the Customize tab, and then click Choose Picture.
3. Select any image on your computer, click Open, and then click OK.
Your folder will have a whole new look. Place it inside another folder that
uses Thumbnails view to see the display. Use pictures to remind you of
the contents of folders, or just to make them more fun.

Tune ClearType to improve Text Readability
With Windows XP, ClearType can improve the resolution of text on your
screen. It improves readability on color LCD monitors with a digital
interface, such as those in laptops and high-quality flat desktop displays.
Readability on CRT screens can also be somewhat improved.
Through a Web-interface you can turn on ClearType (if you don’t have it
on already) and customize it so it looks best on your screen. Go to
http://www.microsoft.com/windowsxp/pro/using/howto/custo
mize/cleartype/tuner/default.asp and follow the instructions on the
Microsoft ClearType tuner page. Select the text sample that looks best,
and then click the Apply button at the bottom of the Web page. This will
save how ClearType looks on your Windows XP system.

Turn on ClearType Font-Rendering Technology
Get that extra text clarity you've always wanted. The incredible Microsoft
ClearType® technology can be enabled in Windows XP to smooth all fonts
at all sizes, making the whole system so much easier to read. Besides
using Web-interface, you can turn it on manually. Here is how:
1. Click Start, click Control Panel, and then click Appearance and
Themes.
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2. Click the Display icon, click the Appearance tab, and then click
Effects.
3. Click the Use the following method to smooth edges of screen
fonts check box to select it, and select ClearType from the list.
4. Click OK, and then click OK again.

Create a Personal Screen Saver
For a great way to put your digital photos to work, try creating a slide
show presentation for use as a screen saver.
1. Right–click an empty spot on your desktop, and then click
Properties.
2. Click the Screen Saver tab.
3. In the Screen saver list, click My Pictures Slideshow.
4. Click Settings to make any adjustments, such as how often the
pictures should change, what size they should be, and whether
you’ll use transition effects between pictures, and then click OK.
Now your screen saver is a random display of the pictures taken
from your My Pictures folder.

Automatically Download Pictures to a Specified Folder
When you’re running Windows XP, you can choose an option that
automatically downloads your pictures to a specified folder whenever you
plug in your digital camera. Windows XP supports the Picture Transfer
Protocol (PTP). When using a Plug and Play camera that supports PTP or
has a Windows Image Acquisition (WIA) driver, just follow these
directions to choose a picture folder:
1. Open My Computer, right-click the camera icon, and then click
Properties.
2. In the Properties dialog box, click the Events tab.
3. Click the Save all pictures to this folder radio button, and then
specify the folder from the list or click the Browse button.
Note: This doesn’t apply to cameras that are detected as removable
media; those use the shell’s AutoPlay stuff, but this technique works
great for PTP cameras and cameras with WIA drivers. Also, the
Delete pictures from camera after saving them command will
not affect cameras that don’t allow the deletion.

Rename a Batch of Digital Image Files
You've shot a ton of pictures at your 20th birthday with your digital
camera, but after downloading, every picture has a non–descriptive,
consecutive number (00000001.jpg) for it. In Windows XP, you can easily
rename the series and remember it for what it is! Here is how:
1. Click Start, and then click My Pictures or whatever folder in which
you've saved the pictures.
2. Switch the view from the default Filmstrip to Thumbnails by
clicking the Views button on the toolbar.
3. Select all the pictures you want to rename by highlighting the last
picture you want, then press and hold the Shift key as you move
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your mouse over them until you include all to be renamed, ending
with the first picture in the list.
4. Right–click the first picture, and then click Rename.
5. Rename the first picture (for instance, birthday20.jpg), then click in
the white space next to one of the pictures.
Just like magic, all the pictures will be renamed in sequence,
birthday20.jpg, birthday20 (1).jpg, birthday20 (2).jpg, and so on!
Note: This tip can also be used to rename a batch of any files, not
just picture files.

Resize Digital Photos Quickly
This features works only when you install PowerToys for Windows XP.
After you install Image Resizer, if you right-click any image file, there
will be a Resize Picture entry in the context menu. Click this, and you’ll
have various quick-resizing options.
Select one and a resized duplicate of the image file will be created. You
can also resize multiple image files at once. Download PowerToys for
Windows XP from Microsoft Windows XP website for free.

Send a Photo by E-mail
With Windows XP, you can send the photos to your love ones by e-mail in
a couple of quick clicks. Here is how:
1. In the My Pictures folder, click the photo you want to send.
2. Under File and Folder Tasks, click E-mail this file.
3. In the Send Pictures via E-mail dialog box, click Make all my
pictures smaller.
4. In the To box, type your friend's e-mail address, change the subject
and message text if you want, and then click Send.

Send a Quick E-mail
If you want to send a quick e-mail, perform one of the following steps:


Type mailto: in the Run: box (found in the Start menu).



Type mailto: in the Address: box of Internet Explorer.



Create a shortcut (for starting a new mail message) by typing
mailto: in the Location text box of the Create Shortcut wizard.

Use the Address Bar to Launch Programs or Web Pages
Windows XP Professional enhanced the functionality of the Address bar to
make it easier to launch your favorite programs. You can add the Address
bar to the taskbar on the bottom of your desktop. Then you can launch
programs simply by entering their names in the Address bar. For
example, to launch Calculator, simply enter calc in the Address bar.
Anything you would normally enter in the Run box on the Start menu can
be entered in the Address bar. The Address bar also lets you quickly go
to any Web page you specify. To add the Address bar to the taskbar,
simply follow these steps:
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1.
2.
3.
4.

Right-click an empty area on the Taskbar.
Point to Toolbars, and then click Address.
Open the Address bar by double-clicking it.
To close, double-click again.

Change Drive Letters in Windows XP
When you add drives to your computer, such as an extra hard drive, a CD
drive, or a storage device that corresponds to a drive, Windows
automatically assigns letters to the drives. However, this assignment
might not suit your system; for example, you might have mapped a
network drive to the same letter that Windows assigns to a new drive.
When you want to change drive letters, follow these steps:
1. Right-click My Computer, and then click Manage.
2. Under Computer Management, click Disk Management. In the
right pane, you’ll see your drives listed. CD-ROM drives are listed at
the bottom of the pane.
3. Right-click the drive or device you want to change, and then click
Change Drive Letter and Paths.
4. Click Change, click Assign the following drive letter, click the
drive letter you want to assign, and then click OK.
You will not be able to change the boot or system drive letter in this
manner. Many MS-DOS-based and Windows-based programs make
references to a specific drive letter (for example, environment variables).
If you modify the drive letter, these programs may not function correctly.

See a pie-chart representation of your disk
If you want to know, how full, your disk is getting, right-click any drive
icon in under My Computer and choose Properties. You'll see a piechart representation of your disk use, a button that launches the Disk
Cleanup utility, and a More Options tab that lists other maintenance
utilities like Windows Component Cleanup, Installed Program
Cleanup and System Restore Cleanup.

Check for Disk Errors in Windows XP
The ScanDisk utility is not available in Windows XP. However, you can
use the Error-Checking tool in Windows XP to check the integrity of your
hard disk. To check for file system errors and bad sectors on your hard
disk, follow these steps:
1. Double-click My Computer, and then right-click the local disk that
you want to check.
2. Click Properties, and then click Tools.
3. Under Error-checking, click Check Now.
4. Under Check disk options, select the Scan for and attempt
recovery of bad sectors check box. Click Start.

Get all the OS Tools you paid for
Not all the Windows tools and toys you need may be installed on your PC,
by default. Open Control Panel>Add or Remove Programs. Click
Add/Remove Windows Components, select an item, and click Details
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(if necessary); to see more subcomponents. Check the items you want,
click OK, and follow the instructions. You may be prompted to insert your
Windows CD to install some of these programs.

Fix Broken Uninstallers
If you try to uninstall a program using the Add or Remove Programs
applet in Control Panel, but the uninstaller refuses to run, some or all of
the program's files may already be deleted. Just reinstall the application
to the same folder it was in, and use Add or Remove Programs again to
delete it properly.

Remove Record of Recently Used Documents
In Windows XP Professional, the Start menu contains a My Recent
Documents folder that contains 15 of your recently used documents. To
remove the record of recently accessed documents follow these steps:
1. Right-click Start, click Properties, and then click Customize.
2. Click the Advanced tab, and then click Clear List. If you're using
the Classic Start menu, click Clear.
Clicking Clear List empties the My Recent Documents folder. It doesn’t
delete the documents from your computer. If you don’t want to include
anything in the My Recent Documents folder, do the following:
On the Advanced tab, click Customize, and then clear the List my
most recently opened documents check box.
Note: In Windows XP Home Edition, My Recent Documents is not
automatically listed on the Start menu. You can turn on this feature
by right-clicking Start, clicking Properties, clicking Customize,
and then selecting the List my most recently opened
documents check box.

Speed up Menu Display
You can use this tip to speed up the way menus display in Windows XP.
1. Click Start, click Control Panel, click Performance and
Maintenance, and the click System.
2. Click the Advanced tab, and under Performance, click the
Settings button.
3. Clear the Fade or slide menus into view check box, and then
click OK. Now when you bring up a collapsed menu, it will expand
without delay.

Speed up the Display of Start Menu Items
An easy way to speed up the display of the Start Menu Items is to turn off
the menu shadow. To do this, follow these steps:
1.
2.
3.
4.
5.

Right click on an open area of the Desktop
Select Properties
Click on the Appearance tab
Click on the Effects button
Uncheck Show shadows under menus
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Speed up the Startup of some CD Burner Programs
If you use program other than the native WindowsXP CD Burner software,
you might be able to increase the speed that it loads. Here is how:
1.
2.
3.
4.

Go to Control Panel / Administrative Tools / Services
Double-click on IMAPI CD-Burning COM Service
For the Startup Type, select Disabled
Click on the OK button and then close the Services window

Compress Files and Folders in Windows XP
Are you running out of room on your hard disk and need some extra
space to install a new program? Don't worry, Windows XP comes to the
rescue. Both Windows XP Professional and Home Edition now include
a zip compression utility that you can use to compress files and folders on
your hard disk. It may also be use to share files and folders with Internet
community or sending a Zip file as attachment with your email to
decrease the file size and transferring time. If you don't see this
command, make sure you've installed this feature. To compress a file:
1. Right–click the file or folder.
2. Point to Send To.
3. Then click Compressed (zipped) Folder.
This will make a compressed folder, identified by a zipper icon, which
displays the same name as the file you compressed. You can also make a
compressed folder from scratch, by following these steps:
1. Right–click the desktop and point to New.
2. Click Compressed (zipped) Folder. Now open the new
compressed folder and drag files inside that you would like to
compress.

Turn Off the Built-in ZIP Support
By default, Windows XP treats ZIP files like folders. If you're not familiar
with ZIP files, this can be convenient. However, if you already have a
utility in place to manage your ZIP files (such as WinZip), this new feature
can just get in the way. To turn this feature off, follow these steps:
1.
2.
3.
4.

Click on the Start button and select Run.
Type regsvr32 /u %windir%\system32\zipfldr.dll, press OK.
Restart you computer for the changes to take effect.
To re-enable the feature at any time, go to the Run command,
type regsvr32 %windir%\system32\zipfldr.dll and press OK.

Create your own Restore Points
Windows XP makes it easy for you to take a snapshot of critical system
files before you make any major changes, such as installing new software,
adding hardware devices, or changing the registry. (Windows XP
automatically creates system restore points, called system checkpoints,
but you can create your own to make it even easier to recover your
system in case of a failure.) To create restore points, follow these steps:
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1. Click Start, point to All Programs, point to Accessories, point to
System Tools, and then click System Restore.
2. In the System Restore dialog box, click Create a restore point,
and then click Next.
3. Type a description for your restore point, such as "Before Office XP"
or so on, then click Create.
If your system fails, press F8 in the boot menu, and then click Last
known good configuration. Windows XP restores your system to the
most recent restore point.

Restore your PC to a Previous Point
If your PC is acting strangely, use System Restore to return Windows to
an earlier, stable condition. To do this follows these steps:
1. Click Start, point to All Programs, point to Accessories, point to
System Tools, and then click System Restore.
2. In the System Restore dialog box, click "Restore my computer to
an earlier time," then click Next, and follow the instructions.

Customize your Drives for System Restore Points
To choose which drives System Restore monitors for changes and how
much space it reserves for its backups, right-click My Computer and
choose Properties. Click System Restore tab, select a drive under
Available drives, click Settings…, and set the controls to your taste. To
turn off any drive for System Restore monitoring, select the drive and
click Settings…, deselect Turn off System Restore on this drive and
click OK.
Note: Do not turn off the drive where your Operating System is
running usually C:/.

Clear/Delete Old System Restore Points
You must keep your system as clean as possible by clearing your Temp
Folder, and Temporary Internet files regularly. But what about other
space stealing files particularly System Restore Points? By default,
Windows XP creates a restore point (approximately 2 MB each) after
installing Windows XP, once every 10 hours that Windows XP is running,
or every 24 hours. It also creates a restore point when you install a new
program, or install an update to Windows XP. To clean them out, first
make sure your system is stable. There will be a brief period when you
won't have a restore point. To clear existing restore points:
1. Click Start, click All Programs, click Accessories, click System
Tools, and then click System Restore.
2. Click the link System Restore Settings on the left panel and add a
check mark beside Turn off System Restore on all Drives, and
click Apply.
3. When you are warned that all existing Restore Points will be
deleted, click Yes to continue.
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All system restore points are deleted. Now you should manually create at
least one restore point for a safeguard. To do this, follow these steps:
1. Click Start, click All Programs, click Accessories, click System
Tools, and then click System Restore.
2. Click the link System Restore Settings on the left panel and uncheck the mark.
3. Click Create a Restore Point, and then click Next.
4. Name your restore point. (such as "After Restore Point Deletion.")

Changing System Restore Settings
By default, WindowsXP uses a large amount of hard drive space for
storing system restore points. If this is not necessary, you can change the
settings by following these steps:
1. Go to Start / Programs / Accessories / System Tools
2. Run System Restore
3. For each drive or partition, you can click on the Setting button to
change how much hard drive space is devoted to each one.
4. There is even the option to turn it off for all drives.

Re-enabling System Restore
If you previously disabled system restore point through the Group Policy
Editor, the option to start it again does not show in the System
Properties. You can re-enable it again by following these steps:
1.
2.

Run the Group Policy Editor (gpedit.msc)
Go to Computer Configuration / Administrative Templates /
System / System Restore
3. Set Turn off System Restore and Turn off Configuration to
Disable
4. Right click on My Computer and select Manage
5. Go to Services and Applications / Services
6. Scroll down to System Restore Service and set it for Automatic
7. Click on the Start button to start the service
8. Close down this window
9. Go back to the Group Policy Editor and configure both to Not
configured
10. Now when you right click on My Computer, there should be a tab
for System Restore and you can configure how much space will
be used.

Increasing Graphics Performance
By default, WindowsXP turns on a lot of shadows, fades, and slides etc to
menu items. Most simply slow down their display. To turn these off
selectively, follow these steps:
1.
2.
3.
4.
5.

Right click on the My Computer icon
Select Properties
Click on the Advanced tab
Under Performance, click on the Settings button
To turn them all of, select Adjust for best performance
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6. The preference is to leave them all off except for Show shadows
under mouse pointer and Show window contents while
dragging

Tone down the special effects to improve performance
If your PC's application windows open too slowly, you can help out by
turning off some of Windows' visual effects. Right-click My Computer
and choose Properties. Select the Advanced tab, and under
Performance, click Settings. On the Visual Effects tab, select "Adjust
for best performance," or choose "Custom" and turn off all the effects
you can live without.

Modify Settings to Improve Performance
Windows XP uses processor time to handle system performance according
to default settings, which can be adjusted for your computing needs. Also,
settings that govern visual effects enhance the appearance of the
Windows XP interface, but can slow down performance. You can fine–tune
settings in Windows XP Professional to improve performance by following
these steps:
1. Right–click My Computer, and then click Properties.
2. Click the Advanced tab, and in the Performance area, click
Settings.
3. On the Visual Effects tab, click the Custom radio button, and then
select which UI features to disable to improve performance.
4. Click the Advanced tab, and in the Processor scheduling area, click
the Background services radio button. Selecting this option
means that background tasks that you want to run while you work,
such as backup utilities or print jobs, will share processor time
equally with programs.
You may need to be logged on as an Administrator to make these
changes. Note that applying these settings may change your current
desktop theme.

Changing the Default Search Settings
By default, when you start a search, you are prompted for what you want
to search for. (e.g. Pictures, Documents, Files, Computers). To change
the preferences, follow these steps:
1.
2.
3.
4.

Click Start menu, point to Search
Click on Change Preferences
Turn off the animated screen character
Change files and folders search behavior (setting it to Advanced
changes the default search screen to be for simply files)
5. Go to Internet search settings and Turn off balloon tips

Changing Programs that Start Automatically
WindowsXP has a similar program, Msconfig, which was available in
Windows98. This allows you to view and change what programs are
automatically started each time you log in. The new version also allows
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you to view and edit the boot.ini file (as well as check for errors and use
several advanced switches)

Re-Installing User Login Pictures
Normally WindowsXP shows assigned pictures for each user on the
system. If you have deleted your user pictures, want to know the
location, or need to reinstall them, they are stored in the C:\Documents
and Settings\All Users\Application Data\Microsoft\User Account
Pictures\Default Pictures directory. If you need to reinstall the
pictures, they can be expanded from the source CD.

Configuring the Original NT Style Logon Screen
If you want to have the original NT style windows logon screen with XP,
simply hold the Ctrl-Alt keys and press the delete key twice. To make a
permanent change so the logon screen is always like the traditional
NT4/2000 style, follow these steps:
1.
2.
3.
4.
5.

Go to the Control Panel
Open up User Accounts
Click Change the way users log on and off
Uncheck Use the Welcome screen
Click on Apply Options

Configuring and Displaying the Classic Start Menu
If you prefer the original Start Menu, you can easily switch it back by
following these steps:
1.
2.
3.
4.
5.

Right click on the Taskbar
Select Properties
Click on the Start Menu tab
Select Classic Start Menu
If you click on the Customize button you can choose to display
Administrative Tools, Favorites, Run, and expanding many of the
sub-menus like the Control Panel.

Getting an Older Program to Run on Windows XP
If an older application gives you trouble when running Windows XP, you
can set the compatibility properties manually so that the program runs in
a different mode, such as Windows 95, or in a different display or
resolution setting. To set the compatibility properties for a program,
follow these steps:
1. Right–click the executable or the program shortcut to the
executable, and then click Properties.
2. Select the Run this program in compatibility mode check box.
3. From the list, select an operating system that the program runs in
comfortably.
4. If necessary, also change the display settings and/or resolution, or
disable the Windows XP visual themes.
Run the program again when you’re finished changing the settings. Adjust
the compatibility settings again if the program is still not running
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smoothly: a program that’s unhappy on Windows 2000 may flourish on
Windows 98.

Roll Back to the Previous Version of a Driver
Have you ever installed a device driver that makes your system unstable?
Well, in Windows XP you can roll back such a change if it causes you
problems! To go back to the previous driver for a device:
1. Click Start, and then click Control Panel.
2. Click
Performance
and
Maintenance,
and
then
click
Administrative Tools.
3. Double–click Computer Management, and then click Device
Manager in the left pane.
4. Right–click the device for which you'd like to roll back the drivers,
and then click Properties.
5. On Driver tab of the Properties dialog box, click Roll Back Driver,
and follow the wizard's instructions.
It's that simple, although you need to be an administrator or a member of
the Administrators group to complete this procedure.

Install the Fax Component
Fax is not installed by default during Windows Setup. To install Fax:
1. In Control Panel, click Add or Remove Programs under Pick a
category to open the Add or Remove Programs dialog box.
2. Click Add/Remove Windows Components to start the Windows
Components Wizard.
3. In the Components list, click to select the Fax Services check
box, and then click Next. Setup installs the Fax services. If
prompted, insert the Microsoft Windows XP compact disc, and then
click OK.
4. On the Completing the Windows Components Wizard screen, click
Finish.
5. In the Add or Remove Programs dialog box, click Close.

Enable and Configure the Fax Service in Windows XP
This step-by-step guidance describes how to enable and configure the Fax
service in Microsoft Windows XP. The Fax service provides complete
faxing capability from within Windows XP including the sending, receiving,
tracking, and monitoring of faxes.
The information provides below are applies on computers running
Windows XP (Professional or Home Edition) and equipped with a modem
to use the Fax component.

Configure the Fax Service
To configure faxing capability built-in Windows XP, follow these steps:
 Click Start, then point to All Programs, then point to
Accessories, then point to Communications, then point to Fax,
and then click Fax Console. The Fax Configuration Wizard starts.
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 On the Welcome to Fax Configuration Wizard screen, click Next.
 On the Sender Information screen, type the information that you
want to be displayed on your fax cover page, and then click Next.
 On the Select Device for Sending or Receiving Faxes screen, click
the modem that you want in the Please select the fax device list.
 If you want to disable the sending of faxes from this computer, click
to clear the Enable Send check box. (Note: The Enable Send
check box is selected by default.)
 Click to select the Enable Receive check box if you want the
computer to receive faxes. (Note: When this check box is selected,
you can click Manual answer if you do not want the computer to
automatically receive faxes. Automatic answering is enabled by
default.) Click Next.
 On the Transmitting Subscriber Identification (TSID) screen, type
the TSID that you want in the TSID box. (Note: The TSID is
mandatory in some areas. This identification information usually
appears in the header area of a received fax and serves to identify
the sending fax machine. This information usually consists of the
sender's fax number and business name.) Click Next.
 On the Called Subscriber Identification (CSID) screen, type the
CSID that you want in the CSID box.
(Note: The CSID that you enter is displayed on the sending fax
machine. This helps to confirm that the fax is being sent to the
correct recipient.) Click Next.
 On the Routing Options screen, click to select the Print it on check
box if you want each received fax to be automatically printed. When
you select this check box, you are able to select a specific printer on
which to print the received fax.
 Click to select the Store a copy in a folder check box if you want
to create an archive copy of each fax. When you select this check
box, you are able to specify the storage location for the fax copy.
 Click Next. On the Completing the Fax Configuration Wizard screen,
confirm the configuration settings in the Configuration Summary
list, and then click Finish.
The Fax Configuration Wizard closes and the Fax Console window opens.
The computer is now configured to send or receive faxes.

Change the Fax Configuration
You can start the Fax Configuration Wizard from within the Fax Console
window. To start the Fax Configuration Wizard, follow these steps:
1. Click Start, point to All Programs, point to Accessories, point to
Communications, point to Fax, and then click Fax Console.
2. In Fax Console, click Configure Fax on the Tools menu to start
the Fax Configuration Wizard.

Bring hidden files into the Open
By default, Windows hides many system files. This can make correcting
problems
difficult.
To
see
all
files,
choose
Tools>Folder
Options…>View. In the 'Advanced settings' list, select Show hidden
files and folders. Click OK. If you want to hide file(s) or folder(s):
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1. Select the file(s) or folder(s) you want to hide.
2. Right-click and select Properties.
3. Select Hidden in Attributes and click OK.
Note: If Show hidden files and folders is selected in the Folder
Options, the file(s) will be still visible but with a dimmed icon. To
hide all files/folders, select Do not show hidden files and folders
option.

Broaden your folder view
If your folders have a margin on the left with links to resources or tasks
you never use, give more screen real estate to your files and folders by
choosing Tools>Folder Options, Use Windows Classic Folders, and
OK. This will remove the Explorer Bar and its "common tasks" shortcuts.

Clean your desktop
If you are tired of icons cluttering your desktop, hide them in Windows XP
by following these steps:
1.
2.
3.
4.

Right-click the desktop and click Arrange Icons By
Uncheck Show Desktop Icons.
Press F5 to refresh the desktop to view the result.
To restore, repeat the steps to bring the icons back.

Controlling AutoPlay
When you put a CD in the drive, Windows gives you a choice of actions
for handling the disc. You can answer once for each type of content; but if
you want to turn AutoPlay off, right-click the CD drive in My Computer
and choose Properties. Under AutoPlay, select a content type from the
list at the top and pick your preferred settings below. To turn AutoPlay off
for a specific type, click Select an action to perform then Take no
action and click OK.

Disable Error Reporting
You can get rid of the Windows XP error report messages if you don't
want to send another one in. To start the System Configuration Utility:
1.
2.
3.
4.
5.

Click Start, and then click Run.
Type msconfig to open the System Configuration Utility.
Click the Services tab.
Clear the Error Reporting Service check box, and then click OK.
Hit Restart to reboot your system. Your computer will now start
without loading the error reporting service.

Remove Icons for USB Devices from Notification Area
If you have an USB device attached to your system, you will notice an
icon in the notification area. When you click this icon, you’re given the
option to stop your hardware before you unplug it. It’s possible that you
never unplug this hardware. To get rid of the icon, follow these steps:
1. Right-click within the notification area, and then click Properties.
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2. In the Display Properties dialog box, click the Appearance tab,
and then click Advanced.
3. On the Taskbar tab, click Customize.
4. Select Safely remove hardware, and in the Behavior column,
click Always hide.
You may also hide the icon for a particular USB device by right-clicking its
icon on the taskbar, and then clicking Hide Icon. USB stands for
Universal Serial Bus. This is the name for a class of hardware that
makes it easy to add peripheral devices (such as a mouse, keyboard,
joystick, or digital camera) to your computer. If your mouse, keyboard,
game controller, scanner, or other device has a USB connector, you can
plug it into a USB port.

Move Portions of your Start Menu
You can make shortcuts on the taskbar that bring up frequently used
items from your Start menu. This is also helpful if you want easy access
to Start menu items on a different part of the screen.
1. Right click on an empty section of the taskbar point to Toolbars and
then click New Toolbar...
2. In the New Toolbar window, browse to your Start menu directory
(c:\documents and settings\Username\Start Menu\Programs\).
3. Choose the folder you want. Click on OK.
4. Rearrange your taskbar by dragging on the vertical bars until only the
folder title is showing. All the actual links will disappear into a double
arrow.
5. Click the double arrow to bring up the menu. You can drag the menu
to another edge of the display to act as a second Start menu. For long
titles, you might want to rename them to something shorter before
you create the shortcut.

Show “More Details” in My Documents & Win Explorer
If you have set the view mode to Details, you can usually view such
default details as:


Name, Size, Type , Modified

If you’re interested in seeing additional file information in Windows
Explorer when your files are set to Details mode, right-click on one of the
column titles/heading in Windows Explorer and choose an item with no
check mark to add that information, (or uncheck to remove it) that
display such fields as:


Attributes, Comment, Author etc.

If you select the More... option at the bottom (or View>Choose
Details… on the main menu), a dialog box displays with additional fields
that you can select.

Open a Folder in Details View
You can explore a folder or drive in detail, instead of in Icon View mode.
Hold down the Shift key and double-click on the folder or drive. This will
bring up a detailed Explorer window of that particular folder or drive.
TIPS & TRICKS

P a g e - 34

Set your Windows so they all have the Same View
If you like to see lists of your files in a certain way—as large icons, for
example, or with detailed information—Windows XP lets you set your view
options for all your folders at once the way you want them. To set the
view options for folders:
1.
2.
3.
4.

On the Tools menu in Windows Explorer, click Folder Options.
Click the View tab.
Set the view for this folder the way you want it to be for all folders.
Click Like Current Folder, then click Yes to confirm, and click OK.
Note: To access Windows Explorer, click Start, point to All
Programs, and then click Windows Explorer.

Using a Folder Type as a Template
Every Windows XP folder provides a list of hyperlinked tasks appropriate
to that type of folder next to the folder contents. For example, the
Pictures folder type contains task links for ordering prints online and for
printing pictures. If you want to use a folder type as a template for a
selected folder, follow these steps:
1. Right–click a newly created folder, and then click Properties.
2. Click the Customize tab.
3. In the Use this folder type as a template list, click the template type
you want to apply, and then click OK.
Now, when you open the new folder, it will contain a hyperlinked task list
common to the type of folder you selected as the template.

Change the Default Opening Folder in Windows Explorer
By default, Windows Explorer opens showing the My Documents folder. To
change the default setting so that all top–level drives and folders are
shown, follow these steps:
1. Click Start, point to Programs, then Accessories, then right–click
Windows Explorer, and click Properties.
2. Under Target field, which reads %SystemRoot%\explorer.exe, add to
make the line read %SystemRoot%\explorer.exe /n, /e,
/select, C:\
3. Click OK.

Using Hibernation or Standby
Hibernate and Standby let you turn off your computer so that when you
restart your system, everything is restored exactly as you left it—
including unclosed programs and documents. In addition, these features
also reduce the power consumption of your computer and any other
devices on your system.

Does your Computer Support Hibernate and Standby?
To put your computer into hibernation, you must have a computer that is
set up by the manufacturer to support this option. Since the available
Power Management options will vary depending on the exact hardware
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configuration you have, the Advanced Configuration and Power Interface
(ACPI) BIOS may be required for enhanced functionality. To determine if
your computer configuration requires a BIOS upgrade, you may need to
consult your computer's documentation or manufacturer. Not all monitors
support hibernation. In most cases you need to update video drivers to
enable hibernation.

Update Drivers for Standby and Hibernation
If your computer won’t enter standby or hibernation, it may require
updated drivers. Power management features, especially standby and
hibernation, rely on device drivers that support power management in
addition to compatible hardware. Incompatible video drivers prevent
these features from working. The built-in VGA driver, for example, is a
bare-bones driver that doesn’t support power management. If standby
and hibernate don’t work, install an updated driver for your display
adapter.

Difference between Hibernation and Standby
Hibernation allows you to leave your computer for an extended time and
still retain your desktop settings. When you put your computer into
Hibernate mode, the Hibernate feature:
 Saves everything in memory on disk
 Turns off your monitor and hard disk
 Turns off your computer
Standby allows you to conserve power when you plan to be away from
your computer for only a brief period—perhaps a few hours. Unlike
Hibernation, information in computer memory is not saved on your hard
disk. Before putting your computer on standby, you should save your
work. When you put your computer into Standby mode, the standby
feature:
 Switches your computer to a low power state
 Turns off devices, such as the monitor and hard disks
 Does not save information in computer memory to disk

To put your computer into hibernation:
1. Click Start, point to Settings, and then click Control Panel.
2. Double-click the Power Options icon.
3. Click the Hibernate tab. If the Hibernate tab is not available, your
computer does not support this feature.
4. Select the Enable hibernate support check box. If you want to
specify a time for automatic hibernation, click a time in Switch to
hibernation. Otherwise, leave this blank.
5. Click Apply.

To put your computer on standby:
1. Click Start, point to Settings, and then click Control Panel.
2. Double-click the Power Options icon.
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3. Click the Advanced tab.
4. Under the When I press the power button on my computer area,
click Standby. If you are using a portable computer, click Standby
under the When I close the lid of my portable computer area.
5. Click OK or Apply, and then turn off the power or close the lid of your
portable computer.

Disabling Hibernation
If you don't want to use up the disk space taken by Hibernation, or don't
need to use it at all, you can easily disable it by following these steps.
1. Open up the Control Panel / Power Options icon
2. Click on the Hibernation icon
3. Uncheck Enable Hibernation

Restore a lost Show Desktop Icon
The Show Desktop icon in the Quick Launch toolbar isn't a normal
shortcut. If you accidentally delete it, you can't recreate it the way you
would a normal shortcut. Instead, launch Notepad and type these lines:
[Shell]
Command=2
IconFile=explorer.exe,3
[Taskbar]
Command=ToggleDesktop
Save the file as 'Show Desktop.scf' in the folder C:\Documents and
Settings\username\ApplicationData\Microsoft\Internet
Explorer\Quick Launch (Replace 'username' with your user account
name).

Removing/Personalizing Desktop Icons to Quick Launch
If you want to streamline your desktop and frequently used applications,
simply drag a desktop icon to the Quick Launch portion of the taskbar.
The re-located icon appears next to the other Quick Launch icons (e.g.,
Internet Explorer, Outlook Express etc).
To remove the icon that still remains on the desktop, locate the icon again
and drag it to the recycle bin. With this icon removed from the desktop, it
will be one less desktop icon to hunt for when you need to start a
commonly used program.

Display the Quick Launch Bar
If you have opened more than one program, you might like to display and
use the Quick Launch bar. The Quick Launch bar makes it easy to access
frequently used programs like Windows Media Player and your e-mail, and
to open an Internet Explorer window. Windows XP loads several programs
in the Quick Launch, including Show Desktop. One click on Show
Desktop minimizes all the programs on your desktop. Another click
restores them just as you left them. To show Quick Launch on the taskbar
do the following:
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1.
2.

If the Quick Launch bar is not displayed, right-click an empty area
on the taskbar and click Properties.
On the Taskbar tab, under Taskbar appearance, select the Show
Quick Launch check box and click OK. After Quick Launch is
displayed, click Show Desktop to minimize all open programs.

Create shortcut icon on your Desktop
1.
2.
3.
4.

Right–click the desktop.
Point to New, and then click Shortcut.
Type osk, click Next.
Type a name for the shortcut, and then click Finish.

Create Shortcuts for Folder or Disk Drive
Folder shortcuts are a new feature of the Windows 2000 shell, allowing
you to make any folder on the user's machine act as if it were another
folder. Unlike traditional shortcuts, Folder shortcuts integrate the target
into the shell namespace, allowing you to present a direct hierarchy. For
example, if you drag and drop an icon for a folder or disk drive to your
Start menu, Windows 2000 creates a shortcut that cascades to expose
the contents of the target of the shortcut. To create a folder or disk drive
shortcut, do the following:
1. Drag and drop a folder or disk drive icon onto your Start menu.
2. Click the Start menu, then point to the folder or drive that you just
moved.

Create a Keyboard Shortcut to Open a Folder
Do you have a folder to which you want instant access from anywhere on
your computer? For example, if you want the My Music folder to pop up
while Internet Explorer or Word is maximized, follow these steps:
1. Select the folder in Windows Explorer.
2. Create a shortcut, and place it on the desktop. (You create a
shortcut by opening the folder, pointing to New on the File menu,
then clicking Shortcut. Drag the shortcut to your desktop.)
3. Right–click the new shortcut, and then click Properties.
4. In the Properties dialog box, click the Shortcut tab, and in the
Shortcut key box, enter a Control key combination or a Control–
Shift key combination, (that is, Ctrl+Alt+M or Ctrl+Shift+M
when M is for music), and then click OK.
Anytime you hit the key combination you specified, your folder will open,
even when other programs are maximized! This tip can be applied to
folders, programs, and text file shortcuts that are placed on the desktop.

Create an Email Shortcut on Desktop
If you have a friend or colleague that you email constantly, you can
create a shortcut on the Desktop so that it opens your default email client
with the email address already inserted for you. Just follow these steps to
create the shortcut:
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1.
2.
3.
4.
5.
6.

Right-click on an empty space on the Desktop
Select New>Shortcut
In the Command line type Mailto:someone@yahoo.com
Click on the Next button
Type in a name for the shortcut
Click on the Finish button

Now, when you double-click on the shortcut, your default email client will
open up with the email already inserted. Simply write your message and
send it off.

Creating a Shortcut of Device Manager to your Desktop
This allows you, to quickly see all the devices attached to your computer.
To add the Device Manager Icon, follow these steps:
1.
2.
3.
4.
5.
6.

Right click on an open area of your desktop
Select New/Shortcut
Type in C:\Windows\Control Sysdm.Cpl, System, 1
Replace C:\Windows with whatever directory you installed
Click on the Next and at the next dialog box type Device Manager
Click on the Finish when you are done. (Replacing the 1 with a 3
will bring up the Performance Status)

Creating a Shutdown/Reboot Shortcut on Desktop
Windows XP has a program called shutdown.exe which allows you to
easily create icons to shutdown or restart your computer. To create a
shutdown shortcut on the desktop, do the following:
1. Right click on an open area of the desktop
2. Select New / Shortcut
3. Enter in "shutdown -s -t 00"(For a reboot, enter "shutdown -r -t
00"- no quotes.
4. Press the Next button
5. For the name, enter anything you like and click Finish button.

Create a shortcut of Windows Explorer on Desktop
To create a shortcut of “Windows Explorer”, on desktop, create a shortcut with
this path: %SystemRoot%\explorer.exe /n, /e, /select, c: Just replace
"c:" with any drive letter or path to have Windows Explorer open right to that
location.

Creating a Shortcut of Printer on your Desktop
One of the fastest and easiest ways to print all kinds of documents on
your computer is to just keep an icon of your printer available on your
desktop. With this icon visible, you can drag and drop all kinds of files to
it and your printer will print them automatically, without having to launch
the application separately.
To add a printer icon to your desktop, in Windows choose
Start>Settings> Printers (Printers and Faxes in XP). Select the printer
you have installed on your system and right-click it. Choose Create
Shortcut from the context menu, and Windows will tell you that it can
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create a shortcut for this item on the desktop. Click Yes, and an image of
your printer appears, ready for the dragging and dropping.

Creating a Suspend Shortcut on Desktop
To create an icon to suspend your computer, follow these steps:
1.
2.
3.
4.
5.

Right click on the Desktop
New / Shortcut
Type rundll32.exe PowrProf.dll, SetSuspendState
Give it whatever name you want like Suspend
Now when you click on that shortcut, your computer will shutdown
and suspend.

Create a Desktop Shortcut to Lock your Computer
You secure your computer by locking it whenever you’re away from your
desk. If you’re on a domain, by pressing Ctrl+Alt+Del and then clicking
Lock Computer, you can prevent unauthorized users from gaining access
to your computer. Only you and members of the Administrators group on
your computer can unlock it. (You unlock it by pressing Ctrl+Alt+Del,
typing your password, and then clicking OK.) To create an even quicker
means of securing your computer, place a shortcut on your desktop to
lock your computer.
1. Right-click an open area of your desktop, point to New, and then
click Shortcut.
2. In the Location box, type: %windir%\System32\rundll32.exe
user32.dll,LockWorkStation
3. Click Next, in the Name box type a name for the shortcut such as,
Lock Computer, and then click Finish.

Create a Shortcut on Desktop to open ClipBook Viewer
Remember the old Clipboard Viewer? It’s also called the ClipBook Viewer
in Windows XP. The ClipBook Viewer shows you the information you have
copied to the Clipboard. You can store information permanently in your
Local ClipBook and share it with other users. The Local ClipBook opens
when you start ClipBook Viewer. The ClipBook Viewer isn’t listed in the
Accessories folder on the Start menu in Windows XP, so you might want
to create a shortcut to it on your desktop:
1. Right-click your desktop, point to New, and then click Shortcut.
2. In the location field, type C:WINDOWS\system32\clipbrd.exe.
3. Click Next to give it a name, then click Finish and you’re all set.

Dragging Shortcuts to a Covered Desktop
If you want to create a shortcut to a file or a folder from inside the
Windows Explorer, but the desktop is hidden or covered by other
applications, you might think that you cannot use the drag and drop
method, but you can.
Just right drag a folder icon from your Explorer to your Taskbar. Be sure
that you hover it over an area on your Taskbar that is not occupied by a
button. Wait for a second, and all the application windows on your
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Desktop will be closed. Continue by dragging the icon onto the Desktop
then select 'Create Shortcut(s) Here'.

Get Back or add Familiar Icons to your Desktop
It is the case of the missing icons. Many of you may be wondering where
all the icons from your desktop are in Windows XP? Well if you are like
me, you like to have at least My Computer, My Network Places, and
My Documents on the desktop. To do this, follow these steps:




Right-click on the desktop, and then click Properties.
Click the Desktop tab and then click on Customize Desktop.
Put a check mark in the box next to My Document, My
Computer, My Network Places, or Internet Explorer, to add
those familiar icons to your desktop.

Get Back to the Desktop Quickly
No matter how many windows you have open; you can always minimize
all of them at once by clicking the Show Desktop button in the Quick
Launch part of the taskbar in Windows XP. If you change your mind and
don't want to use the desktop, you can click the Show Desktop button
again to restore all of your windows.
Note: If you don't see the Show Desktop button, right–click an
empty part of the taskbar, point to Toolbars, and make sure Quick
Launch is checked. If it’s not, then click it.

Get Keyboard Control of the Desktop
Using keyboard shortcuts is a great time-saver, but I have always had
trouble getting keyboard control of the desktop without having to use the
mouse. Here is how to access icons on the desktop using the keyboard:
1. Press the Windows Logo key, which brings up the Start menu.
2. Press Esc (this makes the Start menu disappear, but keeps the
taskbar active).
3. Press Shift + Tab one time (this toggles between the taskbar and
the desktop). Your desktop will now be active, although you may
not notice any visual indication of it.
4. Press the Down cursor key and you will see which desktop icon is
active, and continue to use the cursor keys to move to the icon you
want to use.
5. Press Enter to run the icon, or press Shift + F10 to see the
context menu for that icon.

Edit Screen Shots with Photo Editor
Microsoft Photo Editor enables you to crop or edit a screen shot prior to
pasting it into your Office document. To edit a screen shot with Photo
Editor, do the following:1. First, capture your screen shot by pressing the Print Screen button.
(To capture the active window only, press Alt+Print Screen.)
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2. On your Windows desktop, click the Start button, point to Programs,
point to Microsoft Office Tools, and then click Microsoft Photo
Editor.
3. On the Edit menu, click Paste as New Image.
4. To select only a portion of your screen shot (the portion you want to
copy to your Office document), click Select on the Standard toolbar,
and then drag your mouse pointer over the area you want to select.
5. On the Edit menu, click Copy.
6. Open the document you want to copy the selection into.
7. On the Edit menu, click Paste.

To format the image, follow these steps:1. Right-click the image and then click Format Picture.
2. In the Format Picture dialog box, choose the formatting options
you want and click OK.
Note: If Microsoft Photo Editor isn't listed under Microsoft Office
Tools on your Start menu, you can install it from your Office XP
installation CD.

Opening Explorer Window to the Directory you want
If you want to create a shortcut for the Explorer to a specific directory,
include the directory you want in the Target. For example:
%SystemRoot%\explorer.exe /n, /e, d:\internet would open the
Explorer to the D:\Internet directory

Work with Applications as a Group
When working with several open programs in Windows XP, you can group
them to cascade, tile, minimize, or close all programs at the same time.
1. Click the items on the taskbar while holding down the Ctrl key.
2. After the items are highlighted, right-click any one and the group
options are displayed on the shortcut menu: Cascade, Tile
Horizontally, Tile Vertically, Minimize Group, and Close Group.

Shut down applications as group by using Task Manager
1. Press Ctrl+Alt+Delete to open Windows Task Manager.
2. On the Applications tab, press and hold the CTRL key while
selecting multiple applications, and then click End Task.

Use the On-Screen Keyboard
An on–screen keyboard is built into Windows XP. It can be useful if you
have mobility impairments, if you are using a tablet PC, or if your
keyboard goes down. To access the keyboard, go to Start, then click
Run, and type osk. Now the keyboard opens on your computer screen,
featuring three typing modes you can use to type data:
 Clicking mode, you click the on–screen keys
 Scanning mode, you press a hot key or use a switch–input device to
type highlighted characters
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 Hovering mode, you use a mouse or joystick to point to a key, which
is then typed

Adding an item to the SendTo Menu
You can create a new shortcut on the Send To menu, for example, one
that goes to a frequently-used folder. Follow these steps:
1. Open My Computer, and double-click the drive where Windows is
installed, which is usually drive C.
2. Double-click the Documents and Settings folder, and then
double-click the folder for the particular user.
3. Double-click the Send To folder.
The SendTo folder is hidden by default. To see the Send To folder, click
Tools, click Folder Options, and then click Show hidden files and
folders.
1. On the File menu, point to New, and then click Shortcut.
2. Follow the instructions to create a shortcut.
Now, when you right-click a file, and click Send To, the shortcut to the
item you selected will be an option. You can create shortcuts to local or
network programs, files, folders, computers, or Internet addresses.

Adding Recycle Bin to the SendTo
Add a Shortcut of Recycle Bin to the SentTo folder. That way you can just
right click on a file you want to delete, and send it to the recycle bin
without having to confirm each time. To do this, follow these steps:
1. Press Win Key + R to open the Run dialogue Box
2. Type “SendTo”
3. From desktop, drag Recycle Bin icon to SendTo folder. This will
create a shortcut there.

Move or Copy Files to Subfolders
You can use Windows Explorer in Windows XP to move or copy a file by
dragging the file icon to a folder. When you have Folders displayed on the
left side of the window, it's easy to drag a file to a different folder.
If the folder you want isn't visible because the folder it's in is not
expanded, here's a trick that will save you time and frustration. Drag the
file icon to the collapsed (unexpanded) folder, and hold it there for a few
seconds. The folder automatically expands and then you can drop the file
into the folder you want.

Toggle the Folders Tree
Regardless of which view you use for a given folder, you can click the
Folders button to toggle between Windows Explorer’s Folders pane
and the menu pane. Use the double arrows at the right of each menu to
collapse or expand the choices shown in that box; in the Details box, the
double arrow toggles the display of information about the currently
selected file or folder (including previews of image files).
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Add Favorites with One Keystroke
You can quickly add a Web page to your Favorites folder with a single
keystroke. The page is automatically added to your Favorites list without
any further input from you. To add to your Favorites list with one
keystroke, Press Ctrl+D.

Skip the Recycle Bin Confirmation Message
When you delete items by moving them to the Recycle Bin, Windows
displays a message confirming the deletion: “Are you sure you want to
send FILENAME to the Recycle Bin?” If you’re tired of clicking an answer
to that question, you can configure Windows XP to skip the confirmation
message whether or not you’re using the Recycle Bin.
1. Right-click the Recycle Bin, and then click Properties.
2. In the Recycle Bin Properties dialog box, clear the Display
delete confirmation dialog check box, and then click OK.
If you don’t want to use the Recycle Bin at all, in the Recycle Bin
Properties dialog box, select the Do not move files to the Recycle Bin.
Remove files immediately when deleted check box.

Use your Keyboard if your Mouse goes dead
If your mouse is not functioning, don't panic. You can use your keyboard
to move around the Windows XP desktop. The keys to get used to are the
Windows key, the arrow keys, and the Enter key. For example, if you
want to shut down the computer so that your mouse is not working:
1. Press the Windows key
2. Press the up arrow key one time to highlight Shut Down, and then
press Enter.
3. Press the up and down arrow key to select Shut Down from the
menu, and then press Enter.
4. Use your Esc key to cancel.

Turn On the Sticky Keys Feature
When a shortcut requires a key combination, the StickyKeys feature lets
you press a modifier key, such as Shift, Ctrl, Alt, or the Windows Logo
key, and have it remain active until another key is pressed. To activate
StickyKeys follow these steps:
1. Press the Shift key five times. A dialog box opens with instructions
on how to set up the StickyKeys feature.
2. If you click OK, an icon (a group of squares) appears in the
notification area. Note: To turn off StickyKeys, press the Shift key
five times.

Turn on ToggleKeys
ToggleKeys is designed for people who have vision impairment or
cognitive disabilities. When ToggleKeys is turned on, your computer
provides sound cues when the locking keys (Caps Lock, Num Lock, Or
Scroll Lock) are pressed. A high sound plays when the keys are switched
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on and a low sound plays when they are switched off. To turn on
ToggleKeys do the following:
1. Click Start, click Control Panel, and then click Accessibility
Options.
2. Click the Keyboard tab, and under ToggleKeys, select the Use
ToggleKeys check box.
o To use the keyboard shortcut which allows you to turn
ToggleKeys on and off by pressing the NUM LOCK key for five
seconds, on the Keyboard tab, under ToggleKeys, click
Settings.
o If the Use shortcut check box in the Settings for
ToggleKeys dialog box is selected, you can turn ToggleKeys
on or off by holding down the Num Lock key for five
seconds.

Controlling the Desktop Cleanup Wizard
By default, the Desktop Cleanup Wizard will pop up every 60 days to
cleanup your desktop. To stop this, follow these steps:
1.
2.
3.
4.
5.

Right click on the desktop.
Select Properties
Click on the Desktop tab
Click on the Customize Desktop button
Uncheck Run Desktop Cleanup Wizard

Using older version of Media Player 6.4
If you want to use the older version of Microsoft Media Player 6.4, it is still
on your computer. Make a shortcut on your desktop to the: C:\Program
Files\Windows Media Player\mplayer2.exe. You can also change the
file associations from this program to set it as the default for all media
types stored in your computer.

Clearing the Page File on Shutdown
Another way to set the computer to clear the pagefile without directly
editing the registry is as follows:
1. Click on the Start button
2. Go to the Control Panel/Administrative Tools/Local Security
Policy /Local Policies
3. Click on Security Options
4. Right hand menu - right click on "Shutdown: Clear Virtual
Memory Pagefile"
5. Select "Enable" and Reboot
Note: If you want to clear the page file on each shutdown, go to
Registry Edit Section of this book to find a tip there.

Turning Off the Built-in CD Burner
If you want to turn off the ability to using the built-in CD burner software
that comes with WindowsXP, follow these steps:
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1.
2.
3.
4.
5.

Open up the Explorer
Right click on the drive that is your CD burner
Select Properties
Click on the Recording tab
Uncheck Enable CD recording on this drive

No To All When Overwriting Files
When overwriting files in the Windows Explorer, there is an option for Yes
To All. This would overwrite any files you would normally be prompted
for. To have No To All, simply hold down the Shift key while you click on
the No option.

Grouping Similar Taskbar Buttons
When you open more than one document in the same program and then
minimize each document, rather that showing separate icons on the
taskbar for each document, WindowsXP groups them under a single icon
for that application. If you want to group, or ungroup, similar taskbar
buttons, follow these steps:
1. Right click on the Taskbar
2. Select Properties
3. Check or Uncheck Group similar taskbar buttons

Closing Multiple Taskbar Items
If you hold down the Control Key when you click on the taskbar icons, it
selects multiple tasks. Then you can simply right-click on the selected
items and choose close group.
Note: This tip works with all windows, not just one application. If
you have the Calculator, IE, and Notepad open, it will close them
all, unlike the group similar items command that only lets you close
all of one type (ex: all IE or all notepads).

Closing Multiple Taskbar Items
If you hold down the Ctrl Key when you click on the taskbar icons,
it selects multiple tasks. Then you can simply right-click on the selected
items and choose close group. This tip works with all windows, not just
one application. If you have the Calculator, Internet Explorer, Notepad
and My Documents open, it will close them all, unlike the group similar
items command that only lets you close all of one type (ex: all IE or all
notepads).

Opening a File by Dragging to Taskbar
If you already have an application showing on the taskbar, a quick way to
open a file is to drag it with from the Explorer to that icon and hold it for a
second or so. The application will re-open with that file loaded.

Easy Access to Folders from the Taskbar
You can quickly access commonly used folders from your Taskbar. Here is
how you can do that:
1. Right click on an open area of the Taskbar
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2.
3.
4.
5.

Select Toolbars / New Toolbar
Browse to the directory you want to add
Now on the toolbar you will see the name of that folder displayed.
Click on the (») to bring up the menu. Point the black triangle (►)
to open any sub-folders as well.

Faster Task Switching
If you installed Windows XP Power Tools from Microsoft, when you
press Alt-Tab to switch between running applications, you get a screen
that shows a small graphic of the window that is of that application along
with its icon. This also takes a long time to display. You can speed this up
and revert back to previous ways task switching is displayed.

To turn this off after you Reboot:
1.
2.
3.
4.
5.

Run msconfig
Click on the Startup tab
Uncheck Taskswitch
Click on the OK button
If you want to keep working, click on Exit without Restart

To turn this off immediately:
1.
2.
3.
4.
5.

Press Ctrl-Alt-Delete
Click on the Processes tab
Highlight TaskSwitch.exe
Click on the End Process tab
Click on the Yes button

Hiding System Tray Icons
With WindowsXP, you can manually select how you want individual icons
in the System Tray to be displayed. Here is how:
1.
2.
3.
4.
5.

Right click on the Taskbar
Select Properties
Check Hide inactive icons
Click on the Customize button
This will bring up a dialog box that will allow you to select one of
three options for your applications: Hide when inactive, Always
hide, or always show
6. Highlight current/past applications and make any changes you like.
7. A small arrow will now appear in the System Tray that will allow you
to show or hide these icons.

Creating a Password Recovery Disk
In case you forget your password, you can create a password recovery
floppy disk beforehand to help you out of this problem. Here is how:
1.
2.
3.
4.
5.

Single-click Start menu
Go to the Control Panel / User Accounts
Click the User Account
On the left hand side, click on Prevent forgotten password
You will need to know your password to create the disk.
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6. If you don't remember your password sometime in the future, click
on the green arrow like normal at the login and you will be
prompted to insert the password recover disk.

Windows XP Command Line Utilities
While there are a lot of command line utilities in Windows XP, here are
some that you have been using lately.
bootcfg
driverquery
getmac
gpresult
netsh
schtasks
systeminfo

Configures, queries, or changes Boot.ini file settings.
Displays a list of all installed device drivers and their
properties.
Returns the media access control (MAC) address and list
of network protocols associated with each address for all
network cards in each computer
Displays Group Policy settings and Resultant Set of
Policy (RSOP) for a user or a computer
You can use commands in the Netsh Interface IP
context to configure the TCP/IP protocol
Schedules commands and programs to run periodically
or at a specific time
Displays detailed configuration information about a
computer and its operating system

Windows XP Common Command Console Utilities
Windows XP comes with quite a few console utilities you can easily run
from the command line. Here are they:
Computer Management
Disk Management
Device Manager
Disk Defrag
Event Viewer
Shared Folders
Group Policies
Local Users and Groups
Performance Monitor
Resultant Set of Policies
Local Security Settings
Services
Component Services

-

compmgmt.msc
diskmgmt.msc
devmgmt.msc
dfrg.msc
eventvwr.msc
fsmgmt.msc
gpedit.msc
lusrmgr.msc
perfmon.msc
rsop.msc
secpol.msc
services.msc
comexp.msc

Using the System File Checker
You can run the System File Checker to verify protected system files.
Command line switches are: sfc [/scannow] [/scanonce] [/scanboot]
[/revert] [/purgecache] [/cachesize=x]




/scannow
/scanonce
/scanboot




/revert
/purgecache
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Scans all protected system files immediately.
Scans all protected system files once.
Scans all protected system files every time the
computer is restarted.
Returns the scan to its default operation.
Purges the Windows File Protection file cache and
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/cachesize=x

scans all protected system files immediately.
Sets the size, in MB, of the Windows File
Protection file cache.

Add Control Panel to your Quick Launch Buttons
One way to add a Control Panel icon to the area next to your start button
(the Quick Launch toolbar) is as follows:
1. Launch Windows Explorer and navigate to the folder of the Quick
Launch toolbar. Usually this is like C:\Documents and Settings\Your
User Name\Application Data\Microsoft\Internet Explorer\Quick
Launch. (Alternately, you can open the Quick Launch folder by
right-clicking in the “Quick Launch” area; located at left side of the
Taskbar and clicking on ‘Open Folder’)
2. Right-click on the right-sided pane (in an empty area), and select
New>Folder from the menu.
3. Name the new folder: Control Panel. {21EC2020-3AEA-1069A2DD-08002B30309D}.
4. This will create a Control Panel shortcut that uses the correct icon
(you may need to Restart Windows for this to show up).
5. If you resize the Quick Launch toolbar so the new icon doesn't quite
fit, you'll see the >> symbol. Click on that >> button, and then
click on the Control Panel menu item. You'll get a menu of all the
Control Panel applets without having to open the Control Panel
window.

Add “Copy To” and “Move To” Options to Context Menu
Copying and moving files in Windows Explorer requires you to open up
multiple copies of Explorer and drag between them. There's a simpler
way: Add “Copy To Folder” and “Move To Folder” options to the right-click
context menu. You'll then be able to browse any place on your hard disk
to copy or move the file to, then send the file there. To do it:
1. Open the Registry Editor by typing regedit at a command prompt
or the Run box.
2. Go to
HKEY_CLASSES_ROOT\AllFilesystemObjects\shellex\ContextMenuH
andlers.
3. Choose Edit > New> Key to create a new key. Call it Copy To and
set the value to {C2FBB630-2971-11d1-A18C-00C04FD75D13}.
4. Create another new key called Move To. Set the value to
{C2FBB631-2971-11d1-A18C-00C04FD75D13}.
5. Exit the Registry.
The changes should take effect immediately. Now when you right-click a
file, the Copy To Folder and Move To Folder options will appear.

Create a Control Panel menu below the Start Button
1. Click the Start button once with your right mouse button. You
should see a right-button menu called a context menu.
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2. You should see the items Open, Explore, and Find on the context
menu. Click Explore with your left mouse button.
3. An Explorer file management window should open. A directory tree
should appear in the left pane, with the right pane displaying the
contents of the Start Menu folder.
4. Right-click any empty space within the right pane. A context menu
should appear. Click New and then Folder.
5. The Explorer will create a highlighted icon called New Folder. Type
in Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}, all
on one line, replacing the words New Folder with this new line.
You must type the period, the curly braces, all four hyphens,
and the hexadecimal numbers exactly as shown. After the closing
of curly brace, press Enter.
Other Folders can be added by following the above instructions:
- Dial-Up Networking: {992CFFA0-F557-101A-88EC-00DD010CCC48}
- Printers: {2227A280-3AEA-1069-A2DE-08002B30309D}
- Inbox: {208D2C60-3AEA-1069-A2D7-08002B30309D}
- My Computer: {20D04FE0-3AEA-1069-A2D8-08002B30309D}
- Recycle Bin: {645FF040-5081-101B-9F08-00AA002F954E}
- Network Neighborhood: {208D2C60-3AEA-1069-A2D7-08002B30309D}
- Desktop: {00021400-0000-0000-C000-000000000046}
- Briefcase: {85BBD920-42A0-1069-A2E4-08002B30309D}
- Fonts: {BD84B380-8CA2-1069-AB1D-08000948F534}

Removing Programs/Applets from the Control Panel
Below is an easier way to remove control panel programs:
1.
2.
3.
4.

Edit control.ini file (usually empty) in your Windows directory.
Under the section [don't load] add the appropriate .cpl file.
For example to get rid of Network add netcpl.cpl=no
This will disable users from accessing the network control panel.

The following are the files that display icons in the Control Panel. They
reside in the \windows\system directory and can be run individually by
typing its CPL file name. If you are missing any icons in the Control
Panel, you want to make sure the CPL file is in the system directory.
Note: If you find yourself using any of these frequently, then you
can simply make shortcuts to them on your desktop.
access.cpl
appwiz.cpl
desk.cpl
findfast.cpl
firewall.cpl
inetcpl.cpl
intl.cpl
joy.cpl
main.cpl

Accessibility properties
Add/Remove Programs properties
Display properties
FindFast
Firewall Settings
Internet properties
Regional Settings properties
Joystick properties
Mouse properties
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mlcfg32.cpl
mmsys.cpl
modem.cpl
ncpa.cpl
netcpl.cpl
nusrmgr.cpl
odbccp32.cpl
password.cpl
powercfg.cpl
sysdm.cpl
themes.cpl
timedate.cpl
wscui.cpl

Microsoft Exchange Service properties
Sound and Audio Devices
Modem properties
Network Connections
Network properties
User Accounts
Data Sources (32-bit ODBC)
Password properties
Power Options
System properties
Desktop Themes (available with Microsoft Plus!)
Date/Time properties
Security Center

Open it now using Run Feature
If you are working with an application and need to open the current user's
folder, click Start>Run. Type in a single period (.) and press Enter. This
will open the current user's folder, usually in C:\Documents and
Settings\{User Name}. If you need to be one level above that, in
C:\Documents and Settings, type 2 periods (..) in the Run dialog. If you
want to open My Computer, type 3 periods (...) in the Run dialog.

Make Pictures Smaller Unavailable
When you try to send pictures through e-mail, you should normally be
given the option to make them smaller. If this option is not available, a
.DLL file may need to be registered. To do so, run:
Start/Run/regsvr32 shimgvw.dll

Removing Thumbs.db Files
When viewing a folder with the Thumbnail view, Windows XP creates a
thumbs.db file. This is a cache of the current pictures in that directory. To
turn this feature off and save a little disk space, follow these steps:
1. Start the Windows Explorer
2. Go to Tools / Folder Options / View
3. In the first section under Files and Folders, check Do not cache
thumbnails
4. Now you can search for the thumbs.db file on your computer and
remove them. No more should be created.

Cleaning the Prefetch Directory
Windows XP has a new feature called Prefetch. This keeps a shortcut to
recently used programs. However, it can fill up with old and obsolete
programs. To clean these periodically go to:
1. Start / Run / Prefetch
2. Press Ctrl-A to highlight all the files
3. Press Delete key on keyboard

Allowing Network Access with Blank Passwords
Although you can log in locally without a password, by default, Windows
XP Pro does not allow network users to access the computer without a
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password. Typically, you will receive an Unknown error 31 if this is the case.
To change this setting, follow these steps:
1. Run gpedit.msc
2. Go to Computer Configuration / Windows Settings / Security
Settings / Local Policies / Security Options
3. Double click on Accounts: Limit local account use of blank
passwords to console login only
4. Disable this option

Installing Additional Monitors
To install additional monitors (up to ten individual monitors):
1. Turn off your computer.
2. Insert your additional Peripheral Component Interconnect (PCI) or
Accelerated Graphics Port (AGP) video adapter into an available
slot.
3. Plug your additional monitor into the card.
4. Turn on your computer. Windows will detect the new video adapter
and install the appropriate drivers.
5. Open Display in Control Panel.
6. On the Settings tab, click the monitor icon that represents the
monitor you want to use in addition to your primary monitor.
7. Select the Extend my Windows desktop onto this monitor
check box, and then click Apply or OK.
8. If the check box is not displayed on your computer, it may be
because your video adapter does not support multiple monitors. See
Notes for information about compatible hardware.

Installing new fonts
Close any open Windows applications, such as Microsoft Word or Microsoft
Outlook®. In Control Panel, click Appearance and Themes. (If you
are using Control Panel Classic view, double-click Fonts).
1. On the File menu, click Install New Font.
2. In the Drives list, click the drive you want.
3. In the Folders list, double-click the folder that contains the fonts
you want to add.
4. Under List of fonts, click the font you want to add (To select more
than one font to add, hold down the Ctrl key, and then click each of
the fonts you want to add). Finally, click OK.

Correcting Corrupted Fonts
If you are having problems with any of your non-true type fonts, follow
these steps to correct the problem:
1.
2.
3.
4.
5.

Click on the Start button and point to Settings
Click on the Control Panel icon
Double-click on the Fonts icon
Search for the Monoytpe Sorts font
Delete this font then reboot your computer.
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A New Thumbnails View
The Thumbnails view in Windows XP has a new twist. If a folder contains
images saved in a common web format, XP will create an icon for the
folder that displays up to four of the images it contains. To show a single
image, right-click on the folder icon, choose 'Properties' and click on the
'Customize' tab. Under 'Folder Pictures', select 'Choose Pictures',
select the picture you want to open in the thumbnail and click OK.

Launch Applications Fast
You can use number keys to launch applications quickly through the
Windows XP Start menu. Here is how:
1. Click on the Start button and point to All Programs
2. Find one of your often used applications, and drag it to the top box
of the Start menu. Before you let go of the mouse button, make
sure the pointer is between two apps listed in that box, if there are
any, so that a black line appears.
3. Right-click on the application, select Rename and add a number
in front of the name (example: '1 Internet Explorer' '2 Outlook
Express'), but don't use the same number twice.
As a result of this trick, the next time you click on the Start button or
press the 'Windows' key, you can press a number key to launch the
corresponding application.

One-Line Notepad Paragraphs
If you are reading a text in Notepad, there may be times when every
paragraph appears as one long line, and to read it, you have to keep
scrolling to the right. This occurs when the Word Wrap setting has not
been checked. To set it, select 'Format' in Notepad's main menu and
click on 'Word Wrap'. The paragraphs will be formatted to fit the width
of the window.

Remove Ads from Messenger
Ads are everywhere. Why tolerate them in Windows XP Messenger? In
just a couple of short steps, you can be ad-free forever. If you are one of
the unlucky people who have rotating ads on the bottom of your buddy
list, follow the steps below to kill them dead:
1.
2.
3.
4.
5.
6.
7.

Exit out of MSN Messenger completely
Locate the file links.txt on your computer
Open the file in Notepad
Highlight and delete the entire contents of the file.
Save the file
Right-click on the file and choose Properties
Check the Read-Only box and click OK

Now when you open MSN Messenger, there will be one basic MSN logo in
the buddy list instead of rotating logos. This basic logo is stored on your
computer, in the messenger program folder, as logo.gif. You can rename
logo.gif to logobak.gif (or delete it altogether) and the normal ad space
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will appear blank. You can also change logo.gif into whatever picture you
choose.

Icons with No Names
Normally, you have to have a name for an icon, you are not allowed to
use just spaces. To create an icon with no name, follow these steps:
1.
2.
3.
4.
5.

Make sure the Numlock key is on
Highlight the icon you want to change
Right-click on the icon and select Rename
Hold down the Alt key and type in '0160'
Press the Enter key

Disabling the Screen Saver
When you are running the Disk Defragmenter, Scan Disk, or the
Compression Agent process, the screen saver can suddenly appear and
cause the process to start over from the beginning. To avoid this problem,
simply start the process then press the Ctrl+Esc keys to bring up the
Start menu. Leaving the Start menu open during the process will keep the
screen saver from running.

Clean Up Old Printer Files
By default, any print jobs sent to a printer will be temporarily spooled to a
folder on your hard drive. Usually these files are then deleted when the
job has printed. Sometimes when things go wrong, however, these
temporary files can be left behind, eating up disk space. If you are not
expecting anything to be printed currently, you may safely delete any files
found
in
that
folder.
You
can
find
the
folder
in
C:\Windows\System32\Spool\Printers. It doesn't hurt to take a look
in there occasionally when you need to free up disk space.

Powering on the Computer with your Mouse
If you have ATX Main Board, ATX case Award Bios, or any Bios that
supports PS/2 Mouse Power On, then you can power on your computer
with a double click. To activate this feature, follow these steps:
1. Restart your computer
2. Then press Del when the BIOS message appears to enter your
CMOS configuration
3. Select Integrated Peripherals from main menu
4. If PS/2 mouse power on disabled, activate it by press page up/
page down key it will became Double-Click
5. Press Esc key to exit
6. Press F10 to save and exit Power off your PC
7. Now double-click the left mouse button,.. Your PC will turn on

Opening Files with other than the Default Application
If you have more than one application you use for the same type of file
(media, text, graphics etc.) Use one as your default player, make a
shortcut to the other player and put it in the C:\Windows\Sendto
folder. When you want to open a file with the non-default application,
right click on the file and send it to the other application.
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Showing Common Tasks in Window
When you open a window from My Computer or the Control Panel, and
you don't see the blue bar with additional options on the left side, you
may simply need to turn on Common Tasks
1. From that same windows, go to Tools>Folder Options
2. Check Show common tasks in folders

Renaming Multiple Files in a Directory
If you want to rename multiple files in the same directory:
1.
2.
3.
4.

Using the Windows Explorer, select all the files you want to rename
Press F2 or right click and select Rename
Enter the prefix for the name you want (e.g. Newname)
This will automatically rename the rest of the files Newname
(1).jpg, Newname (2).jpg etc.
5. Make sure you include the extension if you have the Explorer
configured to show them.

Having Icons with No Name
Normally, you have to have a name for an icon, just spaces are not
allowed. To create an icon with no name attached, follow these steps:
1.
2.
3.
4.
5.
6.

Make sure NumLock is on
Highlight the Icon you want to change
Right-mouse click and select Rename
While holding down the Alt key, type 0160
Now the icon will have no name below it.
To restore, simply rename with the text you want.

Open Explorer & System Properties from My Computer
By holding Shift key and double-clicking My Computer, you get an
Explorer view of My Computer.
By holding down Alt key and double-clicking My Computer, you get the
System Properties of Control Panel.

Expanding and Contract All Subfolders in Explorer
To quickly have Explorer expand all subfolders for a selected drive or
folder, simply press the asterisk (*) key on the numeric keypad and to
contract press (-) key on the numeric keypad.

Bringing up the Properties Window using Keyboard
While holding the ALT key, double click on an icon to bring up the
properties.

Open any Location/Program via Keyboard
You can find files very quickly in Windows Explorer by simply typing the
first few characters of the file name you are looking for. This is easier and
quicker than scrolling through the list.
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To see what we are talking about, run Windows Explorer and press the
Tab key to get to the right pane. Now, let us say you want to open
“Windows” and then locate Notepad.exe. Assume that your Explorer
opens to the root folder of drive C. Press W and you will most likely see
that Windows is selected. If not, try typing WI. When Windows is
selected, press Enter to open the folder. Type NO and Explorer selects
Notepad.exe. To run Notepad, just press Enter.

Quick shortcuts
 Change between applications by pressing Alt + Tab. You can also
use Win Key + Tab to change between applications.
 Press Win Key + D to minimize your desktop (minimize all open
windows), and same to reverses it.
 In Windows Mail, you can reply to an e-mail with Ctrl + R. Forward
one with Ctrl + F. Send a message you've just written by pressing
Ctrl + Enter. Send and receive all mail with Ctrl + M (or F5).
 To insert Degree symbol (°), press Alt-248
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